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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site. You can store your issues of 
MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from Mavericks) to have it appear on your iPhone and iPad (inside iBooks) 
next time you sync. Or print it out, even – and please feel free to pass MagBytes on. 
MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by Mac NZ for this purpose 
only. Find out more about the MagBytes Apple newsletter online (click on Mac NZ MagBytes Newsletter at top centre).

June 2016  
•2——Mac News ~ Brexit and 

Apple, Thunderbolt Display, 
Campus 2, Non-Retina MacBook 

Pro, GOP, Life is Strange, 
influential Apple exec 

•4——Updates ~ RAW for 15, 
Safari 10, Sierra, APFS, Photos, 

Creative Cloud, AirPorts  
•5——Mac Help ~  

Around New Zealand 
•6—— iOS & iDevice news 

~ iOS 10, Swift Playgrounds, 
UE app, iKlip A/V, Sonos, 

CloudMine, watchOS 3, Netflix  
•8——Apple & Talk ~ No More 

Thing at WWDC, and  
product proliferation 

•10——Tips & Tricks ~ Mac 
and iOS tips for Mail, Contacts, 

taking pictures, Safari and more

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

Apple CEO Tim Cook introducing WWDC this year. The event gave us ... no hardware at all, and just showcased the forthcoming iOS 
10 and the renamed Mac OS: the next iteration will be called macOS 10. The first version will have the code name ‘Sierra’. 
(See the new MagBytes feature Apple & Talk, page 8). 
One of the announcements was Swift Playgrounds (inset right), an iPad app that will help teach kids (and others) to code in a fun way. 
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Mac News Brexit ~ Thunderbolt Display discontinued ~ Campus 2 batteries

How Brexit affected Apple
The surprise Leave vote meant the Euro and British 
Pound both subsequently dropped significantly as 
markets worldwide recoiled in shock. The Brexit news 
helped send the price of Apple’s shares downward by 
2.8%, from an already low valuation hovering around 
$96 over the past week to close at $93.40. However, 
Apple’s shares buffeted the news better than most.
The NASDAQ stock market (where Apple’s shares 
trade) was down by more than 4% overall. Amazon, 
Microsoft and Google saw their shares drop by 
between 3.2 and 3.95%. Companies doing business in 
the UK will have to face an unknown set of new trade 
agreements and other regulation changes.

Apple kills the Thunderbolt Display
On June 23rd, Apple announced that the aging, 
obsolete, overpriced (at NZ$1899) Thunderbolt 
Display was being discontinued. No replacement 
Apple display has been announced [but something 
still could be], and customers have been directed to 
third party products. But since the Apple display is 
the natural partner for Apple’s tower, what does this 
mean for the Mac Pro? Meanwhile, here are six good 
alternatives.

Apple’s Campus 2 to use fuel cells 
As part of efforts to generate clean energy at 
its Campus 2 headquarters, Apple is investing in 
environmentally friendly fuel cells installed by Bloom 
Energy, which supplied units for the Maiden, NC data 
centre.

61 Hurstmere Road, Takapuna 09 486 1493

Authorised to service iPod, 
iPad and Mac

www.istorenz.com

Enhancing Your Apple Experience

Scan QR Code to quickly 
get in touch with iStore

More news: www.mac-nz.com
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Mac News Non-Retina MacBook Pro, no GOP backing, Life is Strange, B St John

Non-Retina MacBook Pro pulled 
Apple Stores are beginning to remove the 
13-inch non-Retina MacBook Pro from 
their showfloors, in what may be a sign 
the company is preparing to completely 
phase out the product with a spinning 
optical disc drive, AppleInsider discovered 
on Monday. Apple last updated the 
computer in 2012.
You only even see this model in the Apple 
online store when you scroll to the bottom 
of the page in the Buy section of the 
MacBook Pro part of the site.

Apple refuses to back GOP
Despite having provided aid in the past, 
Apple is withholding financial and 
technological support from this year’s 
Republican presidential convention (the 
GOP) thanks to the controversial positions 
of candidate Donald Trump, a report has 
claimed. 
Google and Microsoft continue to support 
the GOP.

Life is Strange, Mac App Store
Life is Strange is now available on the 
Mac App Store. It requires macOS 10.11 or 
higher and costs NZ$7.49/US$4.99. That 
gets you the initial episode; the additional 
episodes are in-app purchases.
Life is Strange is a five-part adventure that 

explores complex issues with story-based 
choice and consequences. 
It explores real world issues (above) with 
a different take on story-based choice and 
consequences.

Influential Bozoma Saint John
The TJ Martell Foundation for Leukaemia, 
Cancer and AIDS Research announced that 
Bozoma Saint John, right, global head of 
Consumer Marketing for Apple Music and 
iTunes was to be honoured at the Women 
of Influence Los Angeles Awards Gala ( 
June 21, at the Ebell Theater).
Saint John stole the show as a Worldwide 
Developer Conference presenter on 
Monday, and will be joined by five other 

honorees, each 
of whom has led 
distinguished 
careers while 
devoting generous 
time and energy to 
causes.
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Updates RAW ~ Safari 10 ~ Sierra ~ Photos ~ Adobe ~ AirPorts ~ Google Earth

RAW Support for 15 new DSLR Cameras
Apple released Thursday Digital Camera RAW Compatibility 
Update 6.20, an update that adds support for 15 new DSLR 
cameras from Canon, Olympus, Panasonic, and Sony.

Safari 10 beta for OS X El Capitan, OS X Yosemite
Apple issued beta versions of Safari 10 for OS X 10.11 El Capitan 
and OS X 10.10 Yosemite last Thursday, granting developers 
access to new features like enhanced Safari Extensions, a 
redesigned Bookmarks interface and more. And here’s how Siri 
will work on Mac.

Sierra will let the Mac be Mac-like
While big updates like iOS 10 and massive 
rethinks like watchOS 3 might have 
commanded the lion’s share of attention 
during Apple’s WWDC keynote and the 
ensuing aftermath of discussion and 
Zapruder-level dissection, it’s worthwhile to pause for a moment 
and consider the state of Apple’s most venerable platform, the 
Mac, writes Dan Moren.

Eight hidden features of  macOS Sierra 
It’s the little things that make the biggest difference, and not 
everything about Sierra was revealed at the WWDC keynote. Here 
are eight hidden features.

New macOS filing system
Apple has been working on APFS since 2014, and that was well 
before Linus Torvalds made his very public, stinging remarks 
about HFS+. Apple engineers could only smile and get back to 
work.

Photos app will recognise 7 facial expressions
A developer has uncovered how Photos will employ facial and 
object recognition to generate Moments and yield search results 
in iOS 10 and macOS Sierra. 
According to Kay Yin, Photos will be able to recognise greedy, 
disgusted, neutral, screaming, smiling, surprised and suspicious.

Adobe updates Creative Cloud
Adobe has just released a set of substantial updates to its 
Creative Cloud family of products and services, including tight 
Adobe Stock integration and advanced technologies like facial 
recognition and content-aware photo cropping.
Macworld has a hands-on, with lots about Photoshop.

Firmware update for AirPorts 
Apple has released firmware updates 
for its wireless AirPort Base Stations. 
According to release notes it fixes a 

vulnerability in which a remote attacker may be able to cause 
arbitrary code execution. The firmware update is available for 
the AirPort Express, AirPort Extreme, and AirPort Time Capsule 
base stations with 802.11n; AirPort Extreme and AirPort Time 
Capsule base stations with 802.11ac. You can obtain the update 
via the AirPort Utility app that’s found in the Utilities folder in the 
Applications folder on your Mac — or by using Launchpad.

Better Google Earth imagery coming
Google has announced the rollout of new imagery for Google 
Earth, and by extension Google Maps. The company said it was 
incorporating a new cloud-free mosaic of Earth in Google Earth 
utilising higher-resolution images from Landsat 8, a satellite 
deployed by the USGS and NASA in 2013.
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Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potters Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac & iDevice training in Grey 
Lynn, Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac 
NZ – but I also run the Grey Lynn Sessions 
in Auckland (click on Training). This is the 
cheapest way to learn, at $40 per session 
in a friendly, group environment. A new 
series is starting Wednesday March 4th at 
7:30pm. 
Please email if you are interested in 
attending, as I only book a room when I 
can guarantee five attendees. The sessions 
are friendly, open to questions at all times 
and are backed up by handouts, and one 
is running now on Wednesday nights 
(7:30pm). I train (one-to-one at your home 
or workplace (in Auckland) for $95/hour. I 
also present to institutions.
Please email Mark for more info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top).

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help Apple assistance, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.
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iDevice news

Logitech ad

Next iOS is 10 – articles on 
coming features
Photos in iOS 10 will recognise 
faces, places and more,; iPads get 
a new Safari split-screen mode; 
the Beta releases give hints of 
what might be in the next iPhone; 
multilingual typing will ease 
autocorrect woes; Messages will 
become a platform; and Control 
Center (sic) will expand; there’s a 
Dark Mode; Maps will offer more; 
and Apple Music gets a 10 redesign 
too. Expect more news about 10 
before its release as developers are 
already using it.

Swift Playgrounds for iPad 
teaches code
At WWDC, Apple introduced Swift 
Playgrounds as a “revolutionary new 
app for iPad that makes learning 
Swift interactive and fun.” The new 
app is a powerful authoring tool any 
developer can use to teach critically 
important software coding skills. 
It should be available in a couple 
of months – and it might be aimed 
at kids, but I’m getting it to gain 
a better understanding of coding. 
Meanwhile, see Apple’s page on it. 

Next iOS ~ Swift Playgrounds will teach code to kids (& me)
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iDevice news UE ~ iKlip A/V ~ Sonos app ~ CloudMine ~ watchOS ~ Netflix

UE updates with Siri trigger 
Logitech-owned Ultimate Ears has 
announced a software update for its 
Boom 2 and Megaboom Bluetooth 
speakers, letting users trigger Apple’s Siri 
or Google Now without having to reach for 
their phone or tablet.
After downloading improved Boom or 
Megaboom iOS apps, people will be able 
to tap the Bluetooth buttons on each 
speaker to trigger Siri on paired devices, 
Ultimate Ears said. The speakers accept 
voice input through built-in microphones.

iPhone broadcast mount
Klip A/V is a mobile solution for 
professional audio and video recording 
with your smartphone. An industry first, 
it’s a system that now gives you the ability 
to capture and monitor pro-quality audio 
on the go thanks to an integrated high-
quality mic preamp and built-in wireless 
receiver support. 
With iKlip A/V you can take your best 
shot, capture your best take and get 
professional broadcast-ready results with 

just your smartphone and your favourite 
microphone.
[These will be available in New Zealand].

Sonos Lock Screen Controls
Sonos has rolled out a new version of 
its iOS controller app. It adds playback 
controls to the iOS lockscreen. Users can 
now control volume, play/pause and seek 
location as well as being able to see album 
art without unlocking their iPhones (and 
from the Apple Watch, too).

CloudMine CareKit SDK for
CloudMine, a secure data healthcare 
platform, has released an iOS SDK 
(software development kit) designed to 
work with Apple’s CareKit framework. 
Built to support native iOS apps, this 
SDK will communicate with CloudMine’s 
Connected Health Cloud.

Inside watchOS 3
Apple Watch will get a new iOS too. It will 
have a swipe-up Control Centre. Glances 
will be no more. Swiping up from watch 

faces now brings up a Control Center with 
quick access to commonly used settings, 
borrowing a design convention from 
Apple’s iOS.

Netflix Picture in Picture on iPad
Streaming video service Netflix has 
updated its iOS app with one of the most 
requested features for the platform, 
Picture in Picture mode on the iPad.
On compatible iOS 9-running iPad Air 
or iPad mini 2 and above, the options 
lets people start playback inside the app 
but continue watching in a thumbnail 
view elsewhere after pressing the Home 
button. 
Pop-up commands can expand or close the 
window, and pause or resume playback.

Hello, Space Black?
Japanese blog Macotakara and 9to5Mac 
are both reporting Apple plans to swap 
space gray for space black, which will 
look more like the Apple Watch’s version 
of space gray (it’s a much darker hue than 
the iPhone uses).
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apple&talk From the occasional Tuesday commentary columns on Mac NZ

WWDC 2016: No More Thing
WWDC this year may have been the usual 
love fest for developers, which is fair 
enough: it is a developers’ conference. 
But with no hardware to introduce, the 
journalists there must have left deflated. 
Steve Jobs famously used to end a string of 
new product/model announcements with 
his ‘one more thing …’. 
This year’s WWDC had no more thing.
This was despite the long-standing 
ruminations on a potential Apple Car, all 
the fuzzy pictures of supposed iPhone 7 
parts, the usual intense poring over patent 
filings, the well-accepted idea that the 
MacBook Pro is due a refresh; the expected 
second generation of Apple Watch… 
Apple clearly has decided to introduce 
hardware from a different songbook, with 
the last three WWDCs in a row all scaling 
down hardware announcements until we 
reached this year’s nothing.
This year’s event wasn’t even referred to 
as a keynote, but as an Apple Special Event 
(you can watch it online), implying Apple 
can hold Special Events whenever it wants. 
Which it can, of course, and as it always 
has – but it’s a change in emphasis.
On the one hand, Apple has redefined 
WWDC as the dedicated engineering 
convention it was always meant to be. On 
the other, it chimes nicely with Apple’s 

penchant not to release new products 
until they’re absolutely ready for market, 
for which we should all be thankful. 
Having to have new hardware ready every 
year at the same time must have been a 
hard task.
But it means we’ll stop looking forward to 
WWDC the way we used to.
Apple still introduced some new things 
at the Bill Graham Auditorium in San 
Francisco: more diversity, for a start. 
Under jobs, pretty much every other 
person who took the stage was a white 
middle aged male like him. This year’s 
stage featured four women amongst the 
usual types.
Even the fact that Swift can be introduced 
to younger programmers now on iPad, 

thanks to Swift Playgrounds, is significant. 
Lots of us older Apple fans can mess 
around with this and get an inkling of what 
coding in Swift is actually like – it may 
even lead to some new careers amongst 
us, too.
Tim Cook started his keynote talking 
about the “unconscionable act of 
terrorism and hate” in Orlando, stressing 
Apple’s diversity, and had everyone stand 
in silence for a moment. It’s hard to 
believe it’s something Jobs would have 
done, at least in this way; Cook brings a 
very welcome humanity to the helm of 
Apple. In other changes, more Apple tech 
was opened up to developers: Maps and 
Siri APIs.

What do you think? Email me with your thoughts.

A still from Apple’s WWDC keynote video 
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apple&talk It’s getting harder to advise people what Mac to get

Too many models
When Steve Jobs returned 
to Apple, almost the 
first thing he did was 
rationalise the Mac 
product lines (remember, 
there was no iPhone or 
iPad in those days – Apple 
just made Macs). He cut 
products by 70%.
It was such a good idea. 
In those days, there were 
so many flavours of Macs, it was really 
hard to work out which ones to buy: the 
Performa 6300? 5320CD? 6360? Or Power 
Macintosh 72300,? 8500? 6400? (That’s 
the other thing – they had meaningless 
names that told you nothing.)
It was a very smart business move by Jobs, 
and thousands of people around the world 
– me included – were relieved.
Meanwhile, all sorts of processes and 
operating procedures changed, too. I 
interviewed a former Apple engineer 
once. He told me that the main difference 
between Microsoft’s approach and 
Apple’s was that Microsoft listened to 
all the product feedback (hardware and 
software) and on the next release, tried to 
add in every feature request. It sounds like 
a sensible approach, but leads to dramatic 
‘feature bloat’. One person in Qatar wants 

their word processor to indent, bold the 
first character and italicise the initial word 
at one command? Put it in … meanwhile, 
99.99% of users don’t know, don’t care, 
and would never use it even if they knew 
it was there. But they soon bemoan the 
milliseconds the new feature adds to 
loading and operation time. All those 
other features hardly anyone cares about 
add up to serious lags and the predilection 
to crash with even more lines of confusing 
code for the software to wade through to 
achieve anything.
Apple’s approach, he told me, was to work 
on the percentage of feature requests that 
added up to a significant user group and 
ignore the rest, leaving it up to users to 
work out how to get what they want, and 
this was apparent in Apple’s hardware and 
software approach. Consider the amount 

of ports Macs could 
have, for example. It’s 
better, for weight/power/
sleekness, to just have a 
few flexible, fast ports 
you can plug expanders 
and adapters into.
Look at what we have 
now: instead of a desktop 
Mac and a laptop mac, we 
have six types of Mac – the 
MacBook Air in two sizes; 

but then there’s the MacBook too, which 
inhabits the same niche (ultraportable, 
sleek, light, not very powerful) – but you 
can get this in several colours.
Then there’s the MacBook Pro, 
which comes in two sizes and several 
configurations … for desktops we have the 
Mac mini (in three configurations), iMac 
(in two sizes and several configurations 
each) and models of the Mac Pro. We don’t 
just have an iPad and an iPhone, we have 
iPad in four sizes and in varieties of specs, 
and we don’t just have iPhone 6s on sale in 
two sizes, but the iPhone 6 is still available 
(in two sizes), plus the smaller all-round 
iPhone SE. Five models!
Confused? You should be. It’s getting hard 
to advise people what to buy again.
What would Steve Jobs say?

What do you think? Email me with your thoughts.
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Emailable text, Contacts, Bluetooth, the Dock and Spaces on Mactips&tricks
1/ Pasting text into emails faster — If you 
have some text on your Mac and paste it 
into a new email, most people select the 
text, choose Copy from the File menu or, 
faster, press the keyboard shortcut for 
Copy (Command-C), go to Mail, open a 
new message, move their cursor to the 
body, and then press the shortcut for 
Paste (Command-V).
But you can do this so much faster that I 
love it to bits, and I think you’ll like it too: 
select some text you’d like to email (or 
send through Messages, or tweet about, 
or add to Notes, etc) and then right- or 
Control-click on it. When you do so, a 
contextual menu appears (below), and one 
of the available options is Share.
Pick Mail and the text you selected is 
inserted right into the body of an email, 
ready for you to send.
If you select Messages or a few of the 

other options, you get a little box overlay 
for you to compose and edit as you see fit.
This works in quite a few places around 
the operating system, including in Safari 
and Mail, so if you need to forward only 
a bit of a message to someone else, for 
example, you can do so.

2/  Sending your whole Contacts list as 
a file — Unfortunately, there’s no obvious 
or easy way to do this, but it is possible. 
Open the Contacts app, and select the All 
Contacts option from the left-hand list. (If 
you don’t see the list this item crowns on 
the left of Contacts, choose View>Show 
Groups or press Command-1.)
Now click on any member to select a single 
card, and then press Command-A to select 
them all. Once they’re all highlighted, go 
up to the File menu and choose Export.
You have to be sure to choose Export 

vCard, and not Contacts 
Archive. 
If you pick the latter, 
whomever you send the 
file to will have their own 
contacts list replaced when 
they attempt to import 
your stuff!

3/ Send specific contacts 
in a file — You can also 

pick a different subset of your contacts 
(a Group) and follow the same process, 
above.

4/ Solving Bluetooth issues — A 
combination of saturation of wifi 
frequencies and Bluetooth’s functional 
limits can make it work less well than 
you’d hope. You can try to reduce 
competing use of the spectrum — if you 
have a baby monitor, remote-door bell, 
older cordless phone, or other wireless 
stuff that uses 2.4GHz, you might move or 
replace it. (Check the labels and manuals 
for frequencies used.)
A wifi base station too close to your 
Bluetooth equipment and computer can 
also be a problem. Most consumer wifi 
access points uses the 2.4GHz band, and 
many also use 5GHz. They use a swath of 
2.4GHz that can deny about one-quarter 
to one-third of the band to nearby 
Bluetooth devices. If you’re in a highly 
congested area, like an apartment building 
or office block, you may have many wifi 
base stations and devices active: you 
simply can’t avoid it.
The Bluetooth controller on a Mac may not 
be able to keep up. The official Bluetooth 
specifications say seven is the maximum 
number of Bluetooth devices that can be 
connected to any Mac at once, but three or 

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes


>>

>
>

Mac NZ

page

11

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2015. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip Enterprises 
2010-2015.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission,   
email 
Mac NZ 

MagBytes
#76

tips&tricks More Mac tips: instant slideshows, including for Photos for iOS

four devices is a practical limit, depending 
on the types of devices since some require 
more Bluetooth data – they’re more 
demanding than other devices. Data-
intensive devices might reduce the total 
number of devices that can be active at the 
same time.
If you can’t make the Bluetooth work 
reliably and there’s an audio input, you 
might switch to running an audio cable for 
more reliability.

5/ The Dock and Spaces — If you’ve set an 
app to run in a specific Space, it’s easy to 
double-click that app in the Dock and be 
taken quickly to the space that contains 
that app. (To define which Space an app 
will run in, right- click the app in the Dock 
and select Options.)
You can avoid having to double-click 
the running app in the dock to jump 
to the desired Space. Go to System 
Preferences>Mission Control. Check the 
box ‘When switching to an application, 
switch to a Space with open windows for 
the application.’
This has the side effect of allowing a 
single-click on the running app in the 
Dock to switch to the Space that contains 
that app. If you have a fast GPU, that 
jump happens quickly, and it’s virtually 
transparent to your work flow.

1/ Instant slideshows in Photos for 
Mac — In the Photos view (from the 
Photos>View menu on your Mac), just 
put your cursor over a moment or 
collection, and then click the play button 
that appears above the thumbnails on 
the right. When 
you do, Photos 
automatically 
selects all the 
thumbnails in 
that moment or 
collection and 
opens the Themes 
panel shown.
Click the theme you 
want (right) and 
click Play Slideshow. 
You can’t trigger an 
instant slideshow while in Year view, but 
you can dip into Albums view and play a 
slideshow based on the All Photos album. 
(Although there’s no official limit to the 
number of pictures an instant slideshow 
can contain, it’s possible that you may 
have too many pictures for your Mac’s 
memory to handle, causing Photos or your 
Mac to crash.)
The Theme panel previews what each 
theme will look like applied to the first 
few pictures while the Music panel gives 
you access to your iTunes library for use as 

background music.
In Albums view, Control-click (or right-
click on your mouse) any album (even 
those created by Photos) and choose Play 
Slideshow from the menu that appears.
To play an instant slideshow of multiple 
albums, select them by Command-clicking 
(holding down the Command hey as you 
click) each one, then Control-click one of 
the selected albums and then choose Play 
Slideshow. The albums play in the order 
in which they appear in Albums view. You 
can also select an album (or several) and 
then click the play button in the Photos 
toolbar at the top of the window.
When viewing the contents of an album, 
make sure you don’t have any thumbnails 
selected by clicking an empty area 
between two thumbnails, and then click 
the play button in Photos’ toolbar. Photos 
automatically includes all the images 
inside the current album in your show. (If 
you did have a thumbnail selected, only 
that image gets included in the show.)
To play a slideshow of just a few pictures 
in the album, select their thumbnails first, 
and click play, Either way, the Themes 
pane opens; click Play Slideshow to start 
the show.
To control the order of pictures inside 
each album, rearrange them in the album 
before you start the slideshow.
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In the Photos Sidebar, Control-click an 
album and choose Play Slideshow from 
the shortcut menu. The Sidebar is Photos’ 
equivalent of iPhoto’s source list. To turn it 
on, choose View> Show Sidebar.

2/ Slideshow controls — Once the show 
gets going, you can pause it by pressing 
the space bar on your keyboard: tap the 
spacebar again to restart it. To move 
through the slides manually, use the left 
and right arrow keys on your keyboard. To 
end the show, press the Esc key or wiggle 
your mouse to summon the slideshow 
controls, and then click the X. Let go 
of your mouse button and after a few 
seconds the onscreen controls disappear.

3/ Instant slideshows on your iOS device 
— You can play instant slideshows in 
Photos for iOS, too, which is handy when 
you’re out and about and you want to 
show off pictures hands-free. To do it, fire 
up Photos on your iOS device, tap Albums 
at the bottom of the screen, and then 
tap an album to open it. Your next move 
depends on which device you have.
On iPad, tap the word Slideshow at 
upper right and the show starts playing. 
The AirPlay icon at upper lets you pick 
the device the show plays on: the iOS 
device or, if you’re on a wireless network, 

tips&tricks More Mac tips: instant slideshows, including for Photos for iOS

an Apple TV-connected monitor. The 
Options button at lower right summons a 
pane that lets you control theme, music, 
whether the show repeats (loops), and 
how long each slide stays onscreen.
On an iPhone or iPod touch it works 
slightly differently. Tap an album to open 
it and then tap Select at upper right. Next, 
tap or drag your finger across thumbnails 
to select some photos or tap Select All 
at upper left. Hold your device in portrait 
position (in lieu of landscape) and then 
tap the Share icon at the lower left. In 
the row of icons that appears at the 
bottom of your screen, swipe left to scroll 
horizontally, and then tap the Slideshow 
icon. Once the show starts to play, tap 
your screen and you get the AirPort and 
Options buttons described earlier. (These 
came from Lesa Snider at Macworld.)

4/ Where are you  out recently deleted 
images in Photos? Apple switched 
behaviour in some release of Photos for 
OS X: now there’s a Recently Deleted 
album with a trash can icon in the sidebar 
whereas formerly there was a menu item 
for it in the File menu. If you haven’t 
deleted anything, the Recently Delete 
album does not appear.
The Recently Deleted album disappears if 
you empty it.

5/ How to set a custom viewing order in 
Photos for Mac — Photos doesn’t allow 
manually set order in any of its main 
views, such as the Photos view, All Photos, 
within moments and so on. You can create 
a Smart Album (New>New Smart Album) 
to grab images that meet criteria, which 
makes it easy to tag an image with a 
keyword and have it automatically added 
to that album. But Smart Albums can 
only be sorted (via the View>Sort menu) 
alphabetically by title, or chronologically 
starting with the oldest or newest photo.
To drag images around without having 
them snap back into a sorted order, you 
have to create a regular Album (File>New 
Album) and add images to it. Then you 
drag as you like. Unfortunately, if you’re 
regularly working with images you want to 
add to that album, you have to add them 
to it by dragging.

Where your recently-deleted images lurk 
on your Mac, in Photos
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tips&tricks Take better photos with your iPhone and iPad

Your iPhone has a pretty good camera, 
especially from the 5 on, and in particular, 
excellent light and image processing 
hardware. But can you take better 
pictures? Of course, if you know  a few 
simple tips …

1/ Go straight into camera — Have you 
ever missed a shot scrabbling for your 
camera in your pocket of bag, tried to 
unlock it with the thumbprint, resorted 
to the code, found the Camera app and 
then … missed the shot? No more. When 
you wake up your iPhone (click a button 
so the screen lights up), notice the little 
camera icon 
at bottom 
right. Put 
your finger on 
this and drag 
it upwards to 
go instantly 
into camera 
mode, 
bypassing 
the unlock 
screen.

2/ Turn on 
the grid — 
You may have 
heard of the 

Rule of Thirds, 
since it has been 
used by artists 
for hundreds of 
years. Basically, 
if you divide 
a rectangle 
in three 
horizontally, 
and in three 
vertically, 
the four 
intersections 
that result 
are used as 
compositional 
focal points (one of them, not all of 
them). If you put your subject on one of 
these points instead of smack-bang in the 
middle, your image immediately becomes 
more artistic, partly because you’ve been 
subconsciously conditioned to this by, you 
know, art, and partly because smack-bang 
in the middle is so overused. So turn on 
your iPhone/iPad/iPod touch camera grid: 
Settings>Photos & Camera>Grid. (The 
lines do not imprint on the images you 
capture.) 

Extra tip: having the grid on also helps line 
things up (buildings, horizons) vertically 
and horizontally.

3/ Shoot videos properly — Have you 
noticed your TV is a horizontal rectangle? 
As is a movie screen? Unless you actually 
have a vertical television – in other words, 
that’s higher than it is wide – please 
remember to shoot videos while holding 
your iPhone HORIZONTALLY (ie, in the 
main picture, above) it’s not going to be 
easy to play a vertically-held video on any 
TV, and it’s not that easy to rotate videos 
to view properly, either. While’s you’re 
at it, use the rule of thirds while you are 
shooting (not exclusively, of course – mix 
it up).

4/ Miss the manual shutter release of a 
camera? It can be hard navigating around 
to find the on-screen shutter button 
(the big round one) to snap a picture, 
particularly if you are holding your iPhone 
above your head, like in a crowd, or in 
another way different to normal. Luckily, 
Apple has enabled the volume control, 
both up and down, as shutter releases. 
Hold the iPhone horizontally, and the 
forefinger of your right hand naturally 
falls on the volume controls (not the Mute 
button; it doesn’t work). Click it and you 
take the picture. Click-and-hold to shoot 
‘burst’ – lots of stills, perfect for getting 
the exact right portrait or the perfect 
frame for an action shot. In Video mode, 
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tips&tricks Better photos, and Safari on Mac and iOS

click once to initiate video recording, and 
click again to stop.

5/ Try Flash in daylight — You already 
have HDR for difficult lighting situations 
(extremes of light and dark in the same 
image for example – HDR stands for 
High Dynamic Range and shoots then 
sandwiches a couple of shots to get 
the best exposure for each end). But 
sometimes, flash is worth turning on, 
too (it’s the little icon at top left of your 
screen while in Camera mode on one of 
the Photo, rather than video, settings as 
above). Tap it and you have three settings 
to choose from: Auto (the iPhone decides, 
according to light), Off (always off) and On 
(even in daylight). 
If someone is facing you with the sun 
behind them, for instance, and you’re close 
enough, the flash can fill in the shadows 
on their face. Taking a picture of a car, 
even in daylight, the flash can add a little 
sparkle to the shiny bits. Try and a couple 
with and a couple without, and compare 
the results. It’s also good at helping 
‘freeze’ moving objects, but note, the flash 
is tiny and has a limited range.

1/ Restore Safari bookmarks from iCloud 
backups — Apple recently added a way 
to restore your synced bookmarks. Visit 
iCloud.com, log in with your Apple ID (the 
email address you have associated with 
iCloud and your iCloud/iTunes/App Store 
password), and open the Settings option.
Scroll to the very bottom of the 
page, which is where you’ll find all of 
your restoring options. Click Restore 
Bookmarks, you’ll see what archives 
are available for recovery. Note this will 
replace ALL of your bookmarks — you can’t 
do any individual folders or links.

2/ Reader View — When you visit sites 
that this Safari feature can work with, a 
little icon with lines appears in the left 
corner of the Smart Search bar. Click 
that icon (or press Command-Shift-R, 
for View>Show Reader) to be taken to a 
clutter-free version of the site – it strips 
out things like ads for clearer reading.

3/ Customise Reader View — Reader 
view in Safari has become customisable 
in El Capitan. Click on the icon on the 
right of the Smart Search bar when you’ve 
got a Reader page open: you can make 
text bigger or smaller, change the font 
entirely, and switch up the colour of the 
background. 

4/ This feature is in iOS 9, too — Follow 
the same steps as above: if you see the 
‘lines’ icon appear in the search bar, tap it 
to switch to Reader view. Then you can use 
the same icon on the right to adjust the 
Reader View settings. Leave this view on 
iOS by tapping the Reader icon again.

5/ Sort bookmarks alphabetically in 
Safari for Mac — The more bookmarks 
you save, the harder it is to find what 
you’re looking for since they’re sorted 
chronologically. To change the order, 
you have to manually sort them yourself 
... tedious! No. The easiest way is to use 
the free SafariSort app or, within Safari, 
start by displaying your bookmarks 
(Bookmarks>Show Bookmarks). Click the 
Edit button at the bottom of the list. 
Now drag them all to a folder in the 
Finder; make sure you don’t select 
Bookmarks Menu, or you won’t be able to 
drag the bookmarks. Display that folder in 
List view (View>As List, in the Finder), and 
click the Name header to sort the files by 
name. Next, press Command-up-arrow, 
and drag that folder onto the bookmark 
list in Safari. All your bookmarks will be 
added to the Bookmarks list. Now move 
the bookmarks out of the folder to the 
Bookmarks Menu, or to your Favorites. 
(Apple really should fix this!) >>
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